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INTRODUCTION: 

 
 
ABOUT HTML 
Hypertext Markup Language is a text-formatting language. What makes it interesting is 
the flexible nature of the web: people using different browsers (Internet Explorer/ 
Netscape/ Opera/ Lynx) will view your web page slightly differently, as will people with 
different monitor resolutions and different color displays.  In the early days of web design, 
it was advisable to keep each individual web page (text and graphics combined) under 
50Kb.    Nowadays, with broadband connections, you can be a bit more flexible, but keep 
in mind that if your page takes too long to load, many users will skip over your site.  
 

Modem speed:   Download time:  1MB of Data: 
14.4 KBps    10 minutes 
28.8 Kbps    5 minutes 
33.6 Kbps    4 minutes 
56 Kbps    2.5 minutes 
DSL     1-2 minutes 
T1     5 seconds 

 
 
 
ABOUT THIS DOCUMENT: 
There are several fine web-authoring programs today that will insert HTML code for you 
(including: Adobe PageMill, Claris HomePage, Symantec Visual Page, SoftQuad HotMetal 
Pro, NetObjects Fusion, Microsoft FrontPage & Microsoft Word).   Two free ones are 
Microsoft FrontPage Express (downloadable at: 
http://www.uct.ac.za/depts/its/webdesign/build/install.htm) and Netscape Composer 
(available with Netscape 6.0 or higher).   These programs use a WYSIWYG editor (What 
You See Is What You Get) and are fairly easy to learn.  This document will concentrate on 
using pure HTML code without a web authoring program; if you understand the underlying 
structure of HTML, you will always be able to create a web page, no matter what 
platform/operating system you are using and what programs you have installed on your 
computer.    
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GETTING STARTED:   
 

 
 
CREATE A LOCAL WEB SITE 
This is approximately 90% of the work.   The advantage of creating it locally (i.e. on your 
hard drive and not accessible to the public) is that you will always have a current backup 
copy of your website and you will be able to test your site before launching it in front of 
the general public.  
 
TOOLS FOR LOCAL WEB SITE: 
You will need a computer (either PC or Mac), a text-editing program (i.e. Notepad, 
WordPad, Microsoft Word) and a web browser  (i.e. Internet Explorer, Netscape).  That's 
all you'll really need to create a local web site, but the following items are also useful: a 
graphics program to edit images & generate colors (i.e. Paint, Photo Editor, Adobe 
Photoshop), a calculator to convert decimal to hexadecimal (for new colors), and a second 
or third web browser for testing purposes (i.e. NCSA Mosaic or Lynx). 
 
NAMING CONVENTIONS: 
There are a few of conventions to use when naming your web files (HTML pages, folders 
and pictures:  use lowercase letters and numbers only, with no special characters or 
spaces.  For web pages, make sure they end in .htm or .html, and for pictures, make sure 
they are JPEG or GIF format and that they end in .jpg or .gif.   Save web pages as text 
documents (i.e. no formatting) with the extension .html or .htm.  If it is the main page of 
your website, name it index.html - this is the default page for your web folder. (i.e. 
http://www.nysoclib.org is equivalent to  http://www.nysoclib.org/index.html) 
 
SMART vs. DUMB QUOTES: 
Smart quotes wrap around the word or phrase (the left double-quote differs from the right 
double-quote) and are unreadable in HTML.   Make sure your word processing program 
uses dumb quotes (i.e. "dumb quotes") when writing web pages.  
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SAMPLE WEB PAGE 
 

 
 
Create a folder on your hard drive to store your web pages.  Open up your text program 
and type:  

 
<HTML> 
<HEAD> 
<TITLE>TEST WEB PAGE</TITLE> 
</HEAD> 
<BODY> 
<H1>TEST WEB PAGE TITLE</H1> 
<HR> 
Congratulations!  You've just created your first web page! 
</BODY> 
</HTML> 

 
Save as text-only (or ASCII) file, with the name test.html in your web folder.  Open your 
web browser (you do not need to be connected to the Internet to create local web pages). 
In  Internet Explorer, select "File->Open->Browse" and find your web folder; In Netscape, 
select "File->Open File").  Select "test.html".   If you are able to view this file in your web 
browser, you have successfully created your first web page.     When writing new HTML 
code or converting text documents into HTML, keep the browser window open to the web 
page to periodically check the code for errors.  Reload the web page ("Refresh") to view 
any recent changes.  
 
 
VIEWING THE SOURCE CODE: 
One of the best ways to become familiar with HTML is to peek at the source code of a web 
page.  In Internet Explorer, select "View" and "Source"; in Netscape, select "View" and 
"Page Source".  
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BEGINNING HTML TAGS: 

 
<HTML></HTML>     
This is the first and last piece of code on your web page.  <HTML> tells the web browser 
that the document is written in Hypertext Markup Language, and </HTML> tells the 
browser that the web document is complete. 
 
<HEAD></HEAD>   
This information will not be displayed on the web page itself, but is used for formatting, 
titles and META tags (which add keywords and flexibility to your web page.  The <HEAD> 
tag comes right after <HTML> 
 
<TITLE></TITLE>    
This is the title of your individual web page.  Anything you type between the two tags will 
be displayed at the top of the web browser (not in the document itself) and will be 
indexed as the name of your web page by most of the search engines.  Example: 
<TITLE>The New York Society Library</TITLE> 
 
<BODY></BODY>   
This is the bulk of your web page.  Anything you put between the <BODY> tags will be 
displayed on the web browser in the main area.  Additional qualifiers you can add to the 
<BODY> tag include:  BACKGROUND, COLOR, TEXT, LINK & VLINK 
 
Right now, your basic web page shell should look something like this: 

 
<HTML> 
<HEAD> 
<TITLE></TITLE> 
</HEAD> 
<BODY> 
</BODY> 
</HTML> 

 
By convention, HTML code is written in uppercase letters, but it's not required.  Paragraph 
returns after tags are optional and more a matter of style and readability.   
 
Alternate HTML alignment: 

<HTML><HEAD><TITLE></TITLE></HEAD><BODY></BODY></HTML> 
 
Alternate HTML case: 

<html><head><title></title></head><body></body></html> 
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HTML:  BODY TEXT TAGS 

 
<H1></H1>     
This is the main header of your web page (generally reserved for titles) and is the largest 
web font your browser will display.  Likewise, <H2></H2> is the second header;  
<H3></H3> is the third header, <H4></H4> is the fourth header, and so on.   <H4> is 
equivalent to the code for boldface on most browsers, with a carriage return added.   
Attributes that can be added to the <H1> tags include ALIGN=LEFT (default), 
ALIGN=CENTER, and ALIGN=RIGHT.  Example: <H1 ALIGN=CENTER>NYSL Main 
Page</H1> 
 
<B></B>      
Anything placed between the <B></B> tags will be in boldface type.  Equivalent to 
<H4></H4>, without the carriage return, in most browsers.  
 
<EM></EM>     
Anything between the <EM></EM> tags will be in italics (or emphasized).   Formerly 
known as:   <I></I> 
 
<PRE></PRE>      
Anything between the <PRE> tags will be preformatted - displayed exactly as it is typed 
on the text document (i.e. spacing and tabs are preserved).  It will also run off the page if 
the browser can't display the entire text and will only be displayed in Courier font.   Used 
when the spacing is of vital importance (i.e. forms, poems).  
 
<P>        
Inserts a blank line after a paragraph of text.   Attributes include: ALIGN="LEFT" (default) 
ALIGN="CENTER", ALIGN="RIGHT" & ALIGN="JUSTIFY".  
 
<BR>     
Inserts a line break after the text.  Will also clear the alignment of a picture if used with 
the attribute CLEAR="LEFT" or CLEAR="RIGHT" (more later). 
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<BLOCKQUOTE></BLOCKQUOTE>  
Indents the text five characters from the left and right (and will use a smaller font in 
NCSA Mosaic).  It creates an instant border around a paragraph of text. 
 
<CENTER></CENTER>  
Somewhat archaic HTML code.  Anything between the <CENTER> tags (including images, 
text, etc.) will be centered on the web browser.   Most web designers prefer to use <P 
align=center>, but all browsers will recognize the <CENTER> tag.    
 
UNORDERED LISTS: <UL></UL>       
Insert a <LI> tag in front of each unique item. The unordered list uses a circle as the 
bullet default  <UL TYPE="circle">. Other options include:  <UL TYPE="square"> & <UL 
TYPE="disc">.  Example:  

<UL> 
<LI>apples 
<LI>oranges 
<LI>pears 

</UL> 
 
ORDERED LISTS: <OL></OL>     
Insert an <LI> tag in front of each unique item. The ordered list uses plain numbers 
as the bullet defaults <OL TYPE="1">. Other options include:  Alphabetic:  <OL 
TYPE="a">, <OL TYPE="A"> and Roman Numerals:  <OL TYPE="i">, <OL TYPE="I">. 
Example:  

<OL> 
 <LI>January 
 <LI>February 
 <LI>March 
</OL> 

 
 
SPECIAL CHARACTERS: 

&quot;   " quotation mark 
&amp;  & ampersand 
&lt;  < less than 
&gt;  > greater than 
&#153;  TM Trademark 
&copy;  © Copyright  
&reg;  ® Registered  

&#188;  ¼ Fraction ¼ 
&#189;  ½ Fraction ½ 
&#190;  ¾ Fraction ¾ 
&eacute;  é acute e 
&egrave;  è grave e 
&ccedil;  ç cedill
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HTML EXAMPLE: 
 
<HTML> 
<HEAD> 
<TITLE>Ozymandius</TITLE> 
</HEAD> 
<BODY> 
<H1 align=center>Ozymandius</H1> 
<HR> 
<BLOCKQUOTE> 
I met a traveler from an antique land, <BR> 
Who said--"Two vast and trunkless legs of stone<BR> 
Stand in the desert . . . . Near them, on the sand,<BR> 
Half sunk a shattered visage lies, whose frown,<BR> 
And wrinkled lip, and sneer of cold command,<BR> 
Tell that its sculptor well those passions read<BR> 
Which yet survive, stamped on these lifeless things,<BR> 
The hand that mocked them, the heart that fed;<BR> 
And on the pedestal, these words appear:<BR> 
'My name is Ozymandius, King of Kings,<BR> 
Look on my Works, ye Mighty, and despair!'<BR> 
Nothing beside remains. Round the decay <BR> 
Of that colossal Wreck, boundless and bare<BR> 
The lone and level sands stretch far away." <BR> 
<P> 
<CENTER> 
<EM>Percy Bysshe Shelley</EM> 
</CENTER> 
</BLOCKQUOTE> 
</BODY> 
</HTML> 
 
We could have also used the <PRE> tag: 
 
<HTML><HEAD><TITLE>Ozymandius</TITLE></HEAD> 
<BODY><H1 ALIGN="CENTER">Ozymandius</H1><HR> 
<PRE> 
I met a traveler from an antique land,  
Who said--"Two vast and trunkless legs of stone 
Stand in the desert . . . . Near them, on the sand, 
Half sunk a shattered visage lies, whose frown, 
And wrinkled lip, and sneer of cold command, 
Tell that its sculptor well those passions read 
Which yet survive, stamped on these lifeless things,... 
  Percy Bysshe Shelley  
</PRE></BODY></HTML> 
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PICTURES: 
<IMG SRC="trojan_horse.jpg"> 

 

 
 
Pictures are where the HTML code starts to get interesting.  The unfettered HTML tag for a 
picture is <IMG SRC="trojan_horse.jpg">, where trojan_horse.jpg is the name of your 
image (in either GIF or JPG format).  IMG is short for image, and SRC is short for source.  
There is no closing </IMG> tag. 
 
Additional attributes can be added inside the image tag. The most useful one is the picture 
alignment: ALIGN="RIGHT" or ALIGN="LEFT", added in this manner:   

<IMG SRC= "trojan_horse.jpg" ALIGN="LEFT">. 
This will align the picture of the Trojan Horse to the left and will wrap the text around the 
image.  If the alignment is not specified, the image will be set to the left and the text will 
continue underneath the picture of the Trojan Horse (to center the image of the Trojan 
Horse, as pictured above, use <CENTER><IMG SRC="trojan_horse.jpg"></CENTER>).  
 
You may wish to force a break in the text that is wrapping around the picture.   To do so, 
add <BR CLEAR="LEFT"> if the image was aligned to the left, and <BR CLEAR="RIGHT"> 
if the image was aligned to the right.  Otherwise, the text will stop wrapping around the 
picture when the picture ends. 
 
If you want the web browser to adjust for the space while the picture is downloading, add 
the qualifiers WIDTH and HEIGHT in the image tag.  The width and height of the picture 
should be given in pixels (example:  < IMG SRC="rizzoli1.jpg" WIDTH="492" 
HEIGHT="344"> from the New York Society Library main page at 
http://www.nysoclib.org) 
  
Some browsers do not have the capability of viewing pictures (i.e. Lynx) and other 
browsers are too slow to download the pictures.  To add functionality for people who are 
not able to view your graphic, add an ALT="explanation" tag to the image.  Not only is 
this considered polite web design behavior, the search engines will also index your image 
if you use this tag.   Our complete image tag now looks something like:  

<IMG SRC="trojan_horse.jpg" ALIGN="LEFT"   
WIDTH="400" HEIGHT="300" ALT="Trojan Horse"> 
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GRAPHICS: 
 

 
http://www.moyra.com/jewels/minentrance.html 

 
There are many pages on the web that offer free use of graphics and images on your 
website (right-click the image to download it to your hard drive in your web folder).  Be 
careful when using these images – there are also many copyrighted pages where you 
have to explicitly ask for permission to use the images (the New York Times will charge 
$200/year for use one of their images) or include author credit for the image on your web 
page (see page 22 for an actual picture permission example).  When in doubt, create your 
images from scratch. Some free (or shared) image web page links are:  
 

• http://www.freeimages.co.uk   Stock Photos 
• http://www.clipartcastle.com   Clip-Art (beware: lots of ads) 
• http://www.neferchichi.com   Egyptian Web Art 
• http://www.4yeo.com    Fonts, Buttons, Dividers, Borders 
• http://www.animfactory.com   Animated GIFs 
• http://www.ender-design.com/rg/  Backgrounds, Bullets, Icons 
• http://www.pdimages.com   Public Domain images  

 
 

 
BANNERS & BUTTONS 

Adobe offers an online utility for making banners and buttons for your website at: 
http://webservices.adobe.com/banner/main.html.  Use the larger-sized fonts for banners 
and the smaller-sized fonts for buttons.  

 
 

BACKGROUND GRAPHICS: 
<BODY BACKGROUND="background.jpg"> 

You can use any sort of picture in GIF or JPG format as the background to your web page.   
To add this feature, use <BODY BACKGROUND="trojan_horse.jpg">.  Use with caution - 
background pictures can overwhelm the text of the document. 
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 COLOR: 
<BODY BGCOLOR="#FFFFFF"> 

 

 
Start-> Programs -> Accessories -> Paint, then Colors-> Edit Colors-> Define Custom 

Colors    
 
Web sites use color information stored in hexadecimal (base 16) notation, with all colors 
broken down into varying degrees of red, green and blue (RGB); the values range from 0 
to 255, or 162 numbers in all.  The RGB values are then converted into base 16 and stored 
as a single number. To do so on manually, open your calculator program, switch to 
scientific notation, type in the decimal number, and select "Hex".  The result will be a two-
digit number or letter combination.   Combine all three RGB hexadecimal values for the 
final web color.   
 

RGB:    R   G   B         Hex Code 
Red:    255  000  000  #FF0000  
Green:  000  255  000  #00FF00 
Blue:   000  000  255  #0000FF  
Black:   000  000  000  #000000 
White:  255  255  255  #FFFFFF  

 
Browser-safe colors (colors that look about the same in all browsers) have the RGB 
values:  000, 051, 102, 153, 204 and 255 (or Hex values: 00, 33, 66, 99, CC and FF).   
All other colors may display differently on different monitors.  To create a new color, open 
up Paint and "Define Custom Color" (see path above).  This will bring up a color wheel 
that will give you the RGB decimal numbers (keep the HSL - hue/saturation/luminosity - 
values in the center; web browsers aren't that sophisticated).  Move the mouse around 
until you get the RGB breakdown, & convert to Hex.   Once you have the hexadecimal 
number, use this directly in your HTML code.  To change the background color to black 
and the text to white, use <BODY BGCOLOR="#000000" TEXT="#FFFFFF">.   To 
change the text to red, use <FONT COLOR="#FF0000">Red Font</FONT>.   Recent web 
browsers also accept color names (<BODY BGCOLOR="black" TEXT="white"> or <FONT 
COLOR="red">), but only for the major colors - older web browsers will not recognize 
these and default to gray & black.  When in doubt, use the hexadecimal number.  See 
Appendix 1 for additional colors.   
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LINKS: 
<A HREF="link.html">Link</A> 

 
 

It is extremely likely that you will want to break your website up into multiple pages and 
sections.   To do so, continue creating web pages and store them in the same folder as 
your main (index.html) page.    Use the index.html page to keep track of all the different 
pages by adding links to these pages. 
 
To add a link to one of your internal pages, type:  <A HREF="poems.html">Link to 
other Poems</A>, where "poems.html" is the name of your second web page, and 
"Link to other Poems" is a bit of text, describing the link.  Whatever you type between the 
<A HREF="link.html"> and </A> tag will be displayed in hypertext, meaning it will be 
underlined and in blue (although you can change both of these attributes with a style 
sheet).  
 
There are two types of links: relative and absolute.  Relative links are used inside your 
web site to link files together; absolute links give the full web address of the page and can 
be used to link to websites other than your own. The link to poems.html is a relative link 
(it works locally on the computer and will work on the web if poems.html is in the same 
folder as index.html); an absolute link looks like <A 
HREF="http://www.poets.com">Poets</A>. Notice that the full path of the document is 
given in an absolute link.    If the website poets.com had included a link back to us on 
their web page, this would be known as a "reciprocal link".     
 
If you have too many individual web pages that you are linking to and wish to subdivide 
them into folders, your web code will change slightly.    To create a web folder, add a 
regular folder to your document and name it something simple (with no spaces).  To link 
to a picture called ozymandius.jpg in the folder named "pictures", use the HTML code: <A 
HREF="pictures/ozymandius.jpg">Ozymandius</A>.  To create a link by clicking on the 
above picture, use:  <A HREF="poets.html"><IMG SRC="pictures/ozymandius.jpg"> 
</A>.   This will insert the picture AND link to the picture (ozymandius.jpg will be 
surrounded in blue to signify a link.  If you wish to remove the blue hypertext border from 
around the picture, add BORDER=0 tag:  <A HREF="poets.html"><IMG 
SRC="pictures/ozymandius.jpg" BORDER=0></A>). 
 
To create a link to an e-mail address, use a special form of HREF called mailto:  <A 
HREF=mailto:webmaster@nysoclib.org>E-mail the webmaster here</A>.     
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FONTS: 
<FONT FACE="times">New Font</FONT> 

FONTS 
 

To change the font for a portion of your document, type <FONT FACE="Arial" 
SIZE=+3>Large-sized Arial Font</FONT>, where "Arial" would be replaced with whatever 
font you wished to use.   When specifying the specific font of your web page is to offer 
several solutions (the browser will check sequentially for each font: i.e.: <FONT 
FACE="Arial, Verdana, Helvetica">Fancy Font Here</FONT>) 
 

PC fonts: 
 Verdana    
 Arial      
 Helvetica    
 Courier New    
 Palatino     
 Times New Roman    

  

Unix fonts: 
 Helvetica    
 Times     

  

Macintosh fonts: 

 Helvetica     
 Courier    
 Palatino    
 Times      
 Verdana     
 Arial     

Generic Font-Families 
 serif  
 sans-serif   
 cursive  
 fantasy  
 monospace

 
 

STYLE SHEETS 
<LINK href="style.css" rel=stylesheet> 

 
Style sheets use a slightly different means of specifying the font; the information for the 
font size, style and color is stored on one page, and all of the web pages reference this 
page in the <HEAD> section.  Style sheets are used to help stabilize the design on all 
related web pages and are a great way to do sweeping web page changes without having 
to change the code on each individual web page.  
 
Sample style sheet (style.css) for the New York Society Library: 

BODY {FONT-FAMILY: times, "times new roman", helvetica, arial;  
BACKGROUND-COLOR: #DEB887} 

P  {FONT-SIZE: 12pt;  
FONT-FAMILY: times, helvetica, arial, sans-serif} 
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TABLES 
<TABLE></TABLE> 

 
 
Use tables to sort elements into rows and columns, or to provide page margins without 
using the <BLOCKQUOTE> tag.  Example:   

 
<TABLE> 
<TR> <TD colspan=5><H3 align=center>OCTOBER CALENDAR</H3> 
<TR> <TH>Monday <TH>Tuesday<TH>Wednesday<TH>Thursday 

<TH>Friday  
<TR> <TD>1  <TD>2  <TD>3    <TD>4      
<TD>5   
</TABLE> 

 
<TABLE></TABLE> signifies the start and end of the table.   <TR> is the tag for the start 
of a new row in the Table.  <TH> is the tag for a table header, and will boldface and 
center the text after it.  <TD> is the tag for a table element – no formatting.    Web-
authoring programs also include the corresponding closing tags: </TR></TH></TD>.   
The proper code for the table below would be:  
 

<TABLE> 
<TR> <TD colspan=5> 

<H3 align=center>OCTOBER CALENDAR</H3></TD></TR> 
<TR> <TH>Monday</TH> 

<TH>Tuesday</TH> 
<TH>Wednesday</TH> 
<TH>Thursday</TH> 
<TH>Friday</TH></TR> 

<TR>
 <TD>1</TD><TD>2</TD><TD>3</TD><TD>4</TD><TD>5</TD>
</TR> 
</TABLE> 

 
To align the rows, use <TR ALIGN="LEFT">, <TR ALIGN="CENTER">, <TR 
ALIGN="right">.  To align the columns, use <TR VALIGN="TOP">, <TR 
VALIGN="MIDDLE">, <TR VALIGN="BOTTOM"> 
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FRAMES 
<FRAMESET></FRAMESET> 

 
 
Frames will split your web browser into different sections. Many people find them 
annoying or distracting on a website, so if you do use them, include an option that allows 
the user to break out of the frame entirely (<A HREF="noframe.html" 
TARGET="_PARENT">No Frames</A>).   Also make sure to add a 
<NOFRAMES></NOFRAMES> option to the body of your HTML code for the browsers too 
old to acknowledge frames.   To frame the document example above, use the following 
code: 
 

<HTML> 
<FRAMESET rows=="*,*,*"> 
 <FRAME SRC="file1.html"> 
 <FRAME SRC="file2.html"> 

<FRAMESET cols="*,*,*> 
  <FRAME SRC="file3.html"> 
  <FRAME SRC="file4.html"> 
  <FRAME SRC="file5.html"> 

</FRAMESET> 
</FRAMESET> 
</HTML> 

 
 

ADVANCED FEATURES: 
Once you've become familiar with basic HTML, there are two advanced features that will 
improve your website:   

I. Javascript adds designer flexibility (C|Net's Stupid Web Tricks:  
http://builder.cnet.com/webbuilding/0-7690.html)  

II. CGI programs add programming flexibility (Matt's Script Archive: 
http://worldwidemart.com/scripts/  
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FINAL PREPARATIONS: 
 

 
 

Once your pages are complete, thoroughly test them out for any errors.    
 

I. Double-check the spelling (especially in the <HEAD></HEAD> portion – it's often 
overlooked) and see if all the images load. 

 
II. Open a different browser (if you're using Internet Explorer, try Netscape.  If 

you're feeling particularly wacky, try testing it out in NCSA Mosaic – very old and 
creaky – or Lynx – entirely text-based) and load your web pages.  

 
III. Change the resolution of your monitor.  Try testing the web page at the smallest 

monitor size and the largest monitor size.  How does your web page adjust?   
 
IV. Crunch your graphics. To save as much space as possible on pictures and text 

without losing too much quality, I like using Spinwave's GIF & JPEG Cruncher 
program, an online free web utility at:  http://www.spinwave.com/crunchers.html  

 
 
 
Aesthetically, the key design elements to look for in your overall web site are:  alignment 
(is everything aligned consistently?), proximity (how easy is it to access the pages?), 
repetition (is there a unifying structure to the web site?) and contrast (are the pages 
visually interesting?). 
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REGISTERING A DOMAIN NAME: 
Visit Network Solutions at http://www.netsol.com/en_US/index.jhtml to see if your 
domain name is available (there are also other domain-registration companies out there; 
some web hosting services include it in the price).  Registration is $70 for two years 
(prices vary depending on the domain extension and company used), at which time you 
will be given first option to renew your domain name for another two years.  
 
 

FREE WEBSPACE 
If the domain name is unimportant or this is a personal website, you may wish to try one 
of the free web space sites:  
 

• LYCOS:     
http://angelfire.lycos.com or http://tripod.lycos.com 
Angelfire offers up to 50 MB space free for your website; Tripod offers similar 
incentives.  Both are owned by Lycos; your website address will be: 
http://membername.tripod.com or http://www.angelfire.com/siteinformation/  
 
• YAHOO:        
http://geocities.yahoo.com 
Geocities offers 15 MB free space, with additional incentives (http://photos.yahoo.com, 
offering another 30MB storage for pictures and photos).   Your website address is 
named by interest  (http://www.geocities.com/Hollywood/Set/9078/index.html) and 
by Yahoo e-mail address (example:  http://www.geocities.com/ikrichter/index.html).  

 
 
 

COMMERCIAL WEBSPACE: 
There are many different commercial providers of web space online 

(see http://www.webhostlist.com for lists and reviews). 
• PIVA.NET:             
http://www.piva.net 
The New York Society Library uses Piva.net to host our website (Silver UNIX account:   
$21.20/month) 
 
• HOMESTEAD:        
 http://www.homestead.com 
Homestead.com offers a standard web package for $29.99/month, which includes 2 e-
mail addresses, 50 MB of storage, and 5 GB monthly traffic.  
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UPLOADING TO THE WEB: 
 

 
 

FETCH 
Macintosh FTP Program 

http://fetchsoftworks.com/ 
 
You will need:   
1.  An FTP (file transfer protocol) program to upload files to your web space (usually 
Fetch for the Macintosh or WS_FTP for the PC) 
2.  The following information from your web host: 

 Host name:  (example: ftp.geocities.com) 
 User ID:  generally the same as your e-mail address  
 Password:  generally the same as your e-mail address 
 Directory path: the location of your website on the server (i.e. 
/usr/public) 

Once you have a FTP (file transfer protocol) connection open to your website, copy the 
files from your hard drive onto your new website.   Transfer all web pages as TEXT (or 
RAW DATA) format and all pictures as BINARY (pictures won't display if they're 
transferred as text).   
 

 
WS_FTP 95 

PC FTP Program 
http://www.ipswitch.com/  
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SEARCH ENGINES 
 

The two best ways to bring visitors into your site are through reciprocal links and search 
engine listings.   In order to be listed on a search engine, it is best to submit your web 
page directly to the search engines (there are services out there that will list your web 
page for you – for an extra charge).  It's free for general listings.  
 
SEARCH ENGINE   URL     LOOK FOR:                      
 

• AltaVista   http://www.altavista.com  "Submit a Site" 
• AOL Search   http://search.aol.com  "How to Add a Site" 
• Direct Hit   http://www.directhit.com  "Add URL" 
• Excite    http://www.excite.com  "Submit a Site" 
• FAST Search   http://www.alltheweb.com  "Submit Your Site" 
• GoTo    http://www.goto.com  "List Your Site" 
• Google   http://www.google.com   "Jobs, Press, Cool Stuff", 

 "Submitting Your Site" 
• HotBot   http://www.hotbot.com  "Submit Web Site"  
• Invisible Web   http://www.invisibleweb.com "Contact Us", then   

"Suggest a Site" 
• LookSmart   http://www.looksmart.com "Submit a Site" 
• Lycos    http://www.lycos.com  "Add your Site to Lycos" 
• MSN Search   http://search.msn.com  "Other Links", "More" 

"Submit URL to Search" 
• Netscape Search  http://search.netscape.com "Add Site" 
• Northern Light  http://www.northernlight.com "Register URL" 
• Open Directory Project http://dmoz.org   "Add URL"  
• WebCrawler   http://www.webcrawler.com "Submit a Site" 
• Yahoo    http://www.yahoo.com   Find your category, then 

"Suggest a Site" 
 

Do not submit your site to the search engines too often (i.e. more than once a week) – 
some search engines will block sites that repeatedly submit.  You only need to submit the 
top page of your site (generally the index.html of the main page) – the search engine 
spider will follow all the links on your page.  

 
Once your site has been submitted, it will take a couple of weeks before it appears on the 
search engine.  Start adding reciprocal links to your page (contact people with similar 
websites and ask if they want to exchange links with you).  
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COPYRIGHT ISSUES: 
 
PUBLIC DOMAIN: 
If the work was published more than 75 years ago, it is in the public domain and may be 
used without asking permission or invoking fair use.  Otherwise, check with the 
author/publisher before you use anything (text/articles/pictures).  
 
COYRIGHT MYTHS:  http://www.templetons.com/brad/copymyths.html 
"If it doesn't have a copyright notice, it's not copyrighted." 
"This was true in the past, but today almost all major nations follow the Berne copyright 
convention. For example, in the USA, almost everything created privately and originally 
after April 1, 1989 is copyrighted and protected whether it has a notice or not. The default 
you should assume for other people's works is that they are copyrighted and may not be 
copied unless you know otherwise. There are some old works that lost protection without 
notice, but frankly you should not risk it unless you know for sure.  
 
It is true that a notice strengthens the protection, by warning people, and by allowing one 
to get more and different damages, but it is not necessary. If it looks copyrighted, you 
should assume it is. This applies to pictures, too. You may not scan pictures from 
magazines and post them to the net, and if you come upon something unknown, you 
shouldn't post that either.  
 
The correct form for a notice is:   "Copyright [dates] by [author/owner]" 
 
You can use C in a circle © instead of "Copyright" but "(C)" has never been given legal 
force. The phrase "All Rights Reserved" used to be required in some nations but is now 
not needed." 
 
SUMMARY:    http://www.templetons.com/brad/copymyths.html 

 These days, almost all things are 
copyrighted the moment they are 
written, and no copyright notice is 
required.  

 Copyright is still violated whether you 
charged money or not, only damages 
are affected by that.  

 Postings to the net are not granted to 
the public domain, and don't grant 
you any permission to do further 
copying except perhaps the sort of 
copying the poster might have 
expected in the ordinary flow of the 
net.  

 Fair use is a complex doctrine meant 
to allow certain valuable social 
purposes. Ask yourself why you are 
republishing what you are posting and 
why you couldn't have just rewritten it 
in your own words.  

 Copyright is not lost because you 
don't defend it; that's a concept from 
trademark law. The ownership of 
names is also from trademark law, so 
don't say somebody has a name 
copyrighted.  

 Copyright law is mostly civil law where 
the special rights of criminal 
defendants you hear so much about 
don't apply. Watch out, however, as 
new laws are moving copyright 
violation into the criminal realm.  

 Posting E-mail is technically a 
violation, but revealing facts from E-
mail you got isn't, and for almost all 
typical E-mail, nobody could wring any 
damages from you for posting it. The 
law doesn't do much to protect works 
with no commercial value.
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NYSL REFERENCE BOOKS: 
 
 
001.6 P The Complete Reference HTML:   

The most comprehensive reference/theory/tutorial to HTML 3.2 and 
4.0; Up-to-date with Netscape 4, Internet Explorer 4 tags and 
Dynamic HTML; includes complete HTML element, font, color, and style 
guides.   
Thomas A. Powell. ©1998.  

 
004.678 R  Information Architecture for the World Wide Web:   

Designing Large-Scale Web Sites.   
Louis Rosenfeld & Peter Morville.  ©1998. 

 
004.678 W     The Non-Designer's Web Book:   

An easy guide to creating, designing and posting your own web site.   
Robin Williams & John Tollett. ©1998. 

 
005.72 D  Elements of Web Design:   

Top web designers share their secrets and strategies.  
Darcy DiNucci with Maria Guidice & Lynne Stiles.  ©1997. 

 
005.72 S  Web Pages the Smart Way:   

A painless guide to creating and posting your own website.   
Joseph T. Sinclair. ©2001. 

 
 


